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Disclaimer 
This document and all the information contained within it is proprietary to Armfield 
Limited. This document must not be used for any purpose other than that for which it 
is supplied and its contents must not be reproduced, modified, adapted, published, 
translated or disclosed to any third party, in whole or in part, without the prior written 
permission of Armfield Limited. 

Should you have any queries or comments, please contact the Armfield Customer 
Support helpdesk (Monday to Friday:  0800 – 1800 GMT). Contact details are as 
follows: 

United Kingdom  International  

(0) 1425 478781 
(calls charged at local rate)  

+44 (0) 1425 478781 
(international rates apply)  

Email: support@armfield.co.uk  

Fax: +44 (0) 1425 470916  

Copyright and Trademarks 
Copyright © 2009 Armfield Limited.  All rights reserved. 

Any technical documentation made available by Armfield Limited is the copyright 
work of Armfield Limited and wholly owned by Armfield Limited. 

Brands and product names mentioned in this manual may be trademarks or 
registered trademarks of their respective companies and are hereby acknowledged. 



 

General Overview 
The Armfield F1-10 Hydraulics Bench and its comprehensive range of optional 
accessories have been developed to instruct students in the many different aspects 
of hydraulic theory. 

Each accessory to the F1-10 is supplied as a complete piece of equipment needing 
no additional service items other than the Hydraulics Bench. When coupled to the 
bench they are immediately ready for use. 

 

The F1-10 Hydraulics Bench 
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Equipment Diagrams 
  

 

 Figure 1:  F1-10 Hydraulics Bench 
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Important Safety Information 

Introduction 
All practical work areas and laboratories should be covered by local safety 
regulations which must be followed at all times. If required Armfield can supply a 
typical set of standard laboratory safety rules.  

Your F1-10 Hydraulics Bench has been designed to be safe in use, when installed, 
operated and maintained in accordance with the instructions in this manual. As with 
any piece of sophisticated equipment, dangers may exist if the equipment is 
misused, mishandled or badly maintained. If the equipment is used in a manner not 
specified by Armfield then the protection provided by the equipment may be 
impaired. 

The F1-10 is a heavy piece of equipment, and should be lifted fork lift if possible. 
Ensure that the arms of the fork lift do not foul the sump moulding in the base of the 
unit. Do not attempt to lift the unit when it is full of water.  

Electrical Safety 
The equipment described in this Instruction Manual operates from a mains voltage 
electrical supply. It must be connected to a supply of the same frequency and voltage 
as marked on the equipment or the mains lead. If in doubt, consult a qualified 
electrician or contact Armfield. 

The equipment must only be connected to a mains supply with a reliable earth 
connection so that the equipment is adequately earthed. 

The equipment must only be operated using a fused electricity supply. Details of 
required fuse ratings can be found in Electrical Supply. 

The equipment must not be operated with any of the panels removed. 

To give increased operator protection, the unit incorporates a Residual Current 
Device (RCD), alternatively called an Earth Leakage Circuit Breaker, as an integral 
part of this equipment. If through misuse or accident the equipment becomes 
electrically dangerous, the RCD will switch off the electrical supply and reduce the 
severity of any electric shock received by an operator to a level which, under normal 
circumstances, will not cause injury to that person. 

At least once each month, check that the RCD is operating correctly by pressing the 
TEST button. The circuit breaker MUST trip when the button is pressed. Failure to 
trip means that the operator is not protected and the equipment must be checked and 
repaired by a competent electrician before it is used. 

Accidents can be avoided provided that equipment is regularly maintained and 
staff and students are made aware of potential hazards. A list of general safety 
rules is included in this manual, to assist staff and students in this regard. The list is 
not intended to be fully comprehensive but for guidance only. 

Please refer to the following notes regarding the Control of Substances Hazardous to 
Health Regulations. 
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Important Safety Information 

Water Borne Hazards 
The equipment described in this instruction manual involves the use of water, which 
under certain conditions can create a health hazard due to infection by harmful 
micro-organisms. 

For example, the microscopic bacterium called Legionella pneumophila will feed on 
any scale, rust, algae or sludge in water and will breed rapidly if the temperature of 
water is between 20 and 45°C. Any water containing this bacterium which is sprayed 
or splashed creating air-borne droplets can produce a form of pneumonia called 
Legionnaires Disease which is potentially fatal. 

Legionella is not the only harmful micro-organism which can infect water, but it 
serves as a useful example of the need for cleanliness. 

Under the COSHH regulations, the following precautions must be observed: 

 Any water contained within the product must not be allowed to stagnate, ie. 
the water must be changed regularly. 

 Any rust, sludge, scale or algae on which micro-organisms can feed must be 
removed regularly, i.e. the equipment must be cleaned regularly. 

 Where practicable the water should be maintained at a temperature below 
20°C. If this is not practicable then the water should be disinfected if it is safe 
and appropriate to do so. Note that other hazards may exist in the handling of 
biocides used to disinfect the water. 

 A scheme should be prepared for preventing or controlling the risk 
incorporating all of the actions listed above. 

Further details on preventing infection are contained in the publication “The Control 
of Legionellosis including Legionnaires Disease” - Health and Safety Series booklet 
HS (G) 70. 
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Description 
Where necessary, refer to the drawings in the Equipment Diagrams section. 

Overview 
The F1-10 Hydraulics Bench is designed as a portable and self-contained service 
module for the range of accessories that are listed later. 

The bench is constructed from lightweight corrosion resistant plastic and is mounted 
on wheels for mobility. The GRP bench top incorporates an open flow channel with 
ledges along both sides to support the accessory on test. The open end of the 
channel incorporates a weir carrier and the walls of the channel incorporate a pair of 
slots for use with accessory F1-13 (Flow over weirs). The weir carrier is also used on 
accessories F1-26 and F1-27 to mount the discharge manifold. 

Volumetric measurement is integral and has been chosen in preference to other 
methods of flow measurement for its ease of use, accuracy and safety in use (no 
heavy weights for students to drop). The volumetric measuring tank is stepped to 
accommodate low or high flow rates. A stilling baffle reduces turbulence and a 
remote sight tube with scale gives an instantaneous indication of water level inside 
the volumetric tank. When used in conjunction with a stopwatch/stopclock (not 
supplied), measurement of the change in level with time allows the volume flowrate 
to be calculated. A measuring cylinder is provided for measurement of very small 
flow rates. 

A dump valve in the base of the volumetric tank is operated by a remote actuator at 
the top. Lifting the actuator opens the dump valve allowing the measured volume of 
water to return to the sump in the base of the bench for recycling. When lifted, a twist 
of 90° at the actuator will retain the dump valve in the open position. An overflow in 
the side of the volumetric tank allows water to return directly to the sump preventing 
the volumetric tank from overfilling if the dump valve remains closed. 

Water is drawn from the sump tank by a self-priming centrifugal pump that is 
mounted in a recess below the sump tank. A panel mounted control valve regulates 
the flow from the pump to an easy-to-use quick release pipe connector situated in the 
floor of the moulded channel in the bench top. The flexible supply pipe on most 
accessories simply attaches to the quick release connector. Where higher flowrates 
are necessary, as in the case of accessories C4-MKII or C6-MKII, the quick release 
connector is unscrewed and a full bore coupling is fitted in its place. No hand tools 
are required for either of these operations allowing rapid interchange of accessories. 

A drain valve, incorporated in a recess at the front of the sump tank, facilitates 
emptying of the sump tank. This valve is used for connecting accessories F1-26 and 
F1-27 where the auxiliary pump can be used in parallel with the pump fitted to the 
F1-10. 

The electrical supply to the pump motor is via a switch and a residual current device 
(RCD) mounted in a recess on the front of the bench. The latter gives increased 
protection to the operator against electrical shock in the event that the equipment 
becomes electrically dangerous. 

Accessories to the Hydraulics Bench 
The following accessories are available for use with the F1-10 Hydraulics Bench: 

F1-11    Dead Weight Calibrator 



Description 

F1-12    Hydrostatic Pressure 

F1-13    Flow Over Weirs 

F1-14    Metacentric Height 

F1-15    Bernoulli's Theorem Demonstration 

F1-16    Impact Of A Jet 

F1-17    Orifice And Free Jet Flow 

F1-17a  Orifice Discharge 

F1-18    Energy Loss In Pipes (Pipe Friction) 

F1-19    Flow Channel 

F1-20    Osborne Reynolds' Demonstration 

F1-21    Flow Meter Demonstration 

F1-22    Energy Losses In Bends 

F1-23    Free And Forced Vortices 

F1-24    Hydraulic Ram 

F1-25    Demonstration Pelton Turbine 

F1-26    Series/Parallel Pumps 

F1-27    Centrifugal Pump Characteristics 

F1-28    Cavitation Demonstration 

C4-MkII-2.5m Multi-Purpose Teaching Flume (2.5m working section) 

C4-MkII-5.0m Multi-Purpose Teaching Flume (5.0m working section) 

C6-MkII-10 Fluid Friction Apparatus 

Each accessory is available with educational software which provides automatic 
calculation of required results using manually input measurements, along with help 
texts detailing experimental procedures. 
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Installation 
  

Electromagnetic Compatibility 
This apparatus is classified as Education and Training Equipment under the 
Electromagnetic Compatibility (Amendment) Regulations 1994. Use of the apparatus 
outside the classroom, laboratory or similar such place invalidates conformity with the 
protection requirements of the Electromagnetic Compatibility Directive (89/336/EEC) 
and could lead to prosecution. 

Electrical Supply 

  F1-10-A F1-10-B F1-10-G 

Green/yellow or 
Green lead 

Earth (Ground) Earth (Ground) Earth (Ground) 

Brown or Black lead Live (Hot) Live (Hot) Live (Hot) 

Blue or White lead Neutral Neutral Neutral 

Fuse Rating 10 A 20 A 10 A 

Voltage 220-230V 110-120V 220V 

Frequency 50Hz 60Hz 60Hz 

  

The mains cable supplied with the equipment is terminated with a plug to suit the 
local electrical supply. Three versions of the F1-10 are available:  

F1-10-A   230V/1ph/50Hz –  mains lead fitted with a 2 pin Shuko European style plug 
with adaptor to 3 pin UK style plug. 

F1-10-B   120V/1ph/60Hz – mains lead fitted with a 3 pin NEMA 5-15P plug. 

F1-10-G   220V/1ph/60Hz – mains lead fitted with 3 pin NEMA 6-15P plug. 

This apparatus is classified as Education and Training Equipment under the 
Electromagnetic Compatibility (Amendment) Regulations 1994. Use of the apparatus 
outside the classroom, laboratory or similar such place invalidates conformity with the 
protection requirements of the Electromagnetic Compatibility Directive (89/336/EEC) 
and could lead to prosecution. 

Water Supply 
A temporary supply of water is required for filling the sump tank (capacity 250 litres). 
Connection to a water supply is not necessary when the bench is in use. 

Drain 
Temporary connection to a drain is required when emptying the sump tank after use. 
A suitable flexible hose (not supplied) should be attached to the drain valve in the 
front wall of the sump tank. 



Installation 

Ensure that the drain is suitable if the water is coloured with dye following flow 
visualisation demonstrations. 

Installation Guide 
The Hydraulics Bench is supplied fully assembled and only requires filling with water 
and connection to an electrical supply for it to be operational. 

When the bench has been encased in a wooden crate, for protection during shipping, 
remove the wooden crate taking care not to damage the bench inside. 

Carefully remove the protective cardboard cover from the bench by raising it 
vertically upwards. 

Remove any additional packaging materials from the measuring cylinder, stilling 
baffle and flexible feed pipe. Ensure that the stilling baffle is located inside the 
volumetric tank adjacent to the rectangular cut-out at the end of the moulded channel 
in the bench top. Place the measuring cylinder and flexible feed pipe in a secure 
location. 

Position the Hydraulics Bench in the desired location on a firm level surface following 
the recommendations in the section ‘Installation Requirements’. 

The F1-10 Hydraulics Bench is designed for static location on a firm level floor. For 
ease of mobility, the bench is mounted on four castors, two of which have brakes. 

A temporary supply of clean, cold water is required for the initial filling of the sump 
tank. A drain is required when emptying the sump tank after use. The water may be 
coloured with dye provided that this is non-staining and safe for student use. 

For ease of mobility, the bench is mounted on four castors, two of which have 
brakes. Release the brakes and position the bench adjacent to the water supply. 

Check that all packaging has been removed from the bench, close the drain valve in 
the front wall of the sump tank and apply the brakes before filling the sump tank with 
water. 

Before filling with water for the first time it is suggested that the bench is cleaned 
using a cloth soaked in warm soapy water to remove any grease or dirt that has 
accumulated during shipping. 

Place a filling hose into the overflow slot in the side wall of the volumetric tank so that 
water will flow directly into the sump tank. Lift the dump valve (sealing ball and 
weight) out of the aperture in the base of the volumetric tank so that the level inside 
the sump tank can be observed. 

Add a few drops of wetting agent to the sump tank, via the aperture in the base of the 
volumetric tank, to minimise the effects of surface tension. 

Note: If too much wetting agent is added foaming will occur and it will be necessary 
to replace the water. 

Turn on the water supply and allow the sump tank to fill until the water level is just 
below the outlet in the bottom of the volumetric tank. 

When the sump tank is full, turn off the water supply and remove the filling hose. 
Replace the dump valve in the base of the volumetric tank and locate the actuator in 
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the raised position so that water can return to the sump tank from the volumetric tank 
(A twist of 90° at the actuator will retain the dump valve in the open position). 

Release the castor brakes and move the bench to the required operating position 
within reach of the electricity supply. 

Attach the flexible feed pipe to the quick release connector on the water inlet in the 
bed of channel. The free end of the feed pipe should be positioned in the stilling 
baffle of the volumetric tank. Close the flow control valve. 

The equipment requires connection to a single phase fused electrical supply. A 4m 
length of cable is supplied with the equipment. The electrical requirements of the 
different versions are described in Electrical Supply. 

Connect the equipment to the electrical supply, ensuring that the label fitted to the 
mains lead on the equipment matches the electrical supply. Switch on the RCD then 
press the TEST button to check that the RCD is operating correctly. The RCD must 
trip. 

Switch on the RCD again. 

Operate the pump ON/OFF switch then slowly open the flow control valve and check 
that water is delivered to the volumetric tank via the flexible feed pipe. 

When the pipework has fully primed and water is flowing steadily into the volumetric 
tank, release the actuator of the dump valve to seal the aperture in the bottom of the 
volumetric tank. Allow the volumetric tank to fill until water returns to the sump tank 
through the overflow. Now check that the sight tube is full and no air bubbles are 
present. Repeat this filling operation a number of times, ensuring that the sight tube 
is free from air bubbles. 

Adjust the water level in the volumetric tank until the surface is level with the step in 
the bottom of the tank. A few drops of wetting agent smeared onto the step will 
enable an accurate level to be achieved. 

If necessary, slacken the securing screws at the top and bottom of the sight tube 
scale and position the scale so that the meniscus of the fluid in the tube is level with 
the black datum line engraved between the lower and upper scales. This will ensure 
that the scale is positioned correctly for volumetric measurements using the low or 
high ranges. 

The hydraulics bench is now ready for use. 

Installing the Software 
Software is available for all accessories designed for use with the F1-10 Hydraulics 
Bench. Once the experimental data is entered, the software will perform the 
calculations required by the experiments presented in the accessory teaching 
manual, reducing the time required to complete the experiments and freeing student 
study time that would otherwise have been spent performing repetitive calculations.  

The software for each accessory includes a Questions section, designed to test a 
student’s knowledge of the theory being demonstrated with that accessory. Some 
calculations may be hidden until the student has answered the questions (in order to 
prove that they can correctly perform the calculations themselves). A Lecturer Mode 
has been provided which avoids the requirement to complete the questions section. 
Should the lecturer wish to demonstrate the equipment, or to test the students in an 
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Installation 

alternative manner, Lecturer Mode can be selected from the Options menu or by 
selecting the mortar board (teacher’s hat) symbol from the toolbar.  

The password required for all Armfield educational software is ‘armfield’. 

Setting Up the Software 

In order to install the software: 

 Insert the CD into CD or DVD/CD drive: 

 Choose 'Run' from the 'Start' menu. 

 Type d:setup (where d: is the drive letter) into the 'Open' box, then choose 
'OK'. 

The Armfield software will be installed onto the hard drive of the computer and a 
program group will be set up within Programs in the Start menu. 
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Operation 
Where necessary, refer to the drawings in the Equipment Diagrams section. 

Operating the Equipment 

Measurement of Volume Flow Rate 

The moulded bench top incorporates a volumetric measuring tank which is stepped 
to accommodate low or high flow rates. 

A remote level gauge, consisting of a sight tube and calibrated scale is connected to 
a tapping in the base of the tank, and gives an instantaneous indication of water level 
inside the volumetric tank. The scale is divided into two zones corresponding to the 
volume above and below the step in the tank. In operation, the volumetric tank is 
emptied by lifting the dump valve, allowing water to return to the sump. When flow 
trough the model on test has stabilised, the dump valve is lowered, retaining the 
water in the tank. 

Timings are taken as the water level rises in the tank. Low flow rates are monitored 
on the lower portion of the scale corresponding to the small volume beneath the step 
(6 litres capacity). Larger flow rates are monitored on the upper scale corresponding 
to the main tank (40 litres capacity). 

When extremely small volumetric flow rates are to be measured, the measuring 
cylinder should be used rather than the volumetric tank. When using the measuring 
cylinder diversion of the flow to and from the cylinder should be synchronised as 
closely as possible with the starting and stopping of the watch. 

All volumetric readings using the volumetric tank should be taken with the stilling 
baffle installed since calibration has been effected in this condition. 

Operating the Software 
Note: The diagrams in this section are included as typical examples and may not 
relate specifically to an individual product.   

The Armfield Software is a powerful Educational and Data Logging tool with a wide 
range of features. Some of the major features are highlighted below, to assist users, 
but full details on the software and how to use it are provided in the presentations 
and Help text incorporated in the Software. Help on Using the Software or Using the 
Equipment is available by clicking the appropriate topic in the Help drop-down menu 
from the upper toolbar when operating the software as shown: 

 

Load the software.  If multiple experiments are available then a menu will be 
displayed listing the options.  Wait for the presentation screen to open fully as shown: 



Operation 

 

Presentation Screen - Basics and Navigation  

As stated above, the software starts with the Presentation Screen displayed. The 
user is met by a simple presentation which gives them an overview of the capabilities 
of the equipment and software and explains in simple terms how to navigate around 
the software and summarizes the major facilities complete with direct links to detailed 
context sensitive ‘help’ texts. 

To view the presentations click Next or click the required topic in the left hand pane 
as appropriate. Click More while displaying any of the topics to display a Help index 
related to that topic. 

To return to the Presentation screen at any time click the View Presentation icon 

 from the main tool bar or click Presentation from the dropdown menu as 
shown: 

 

For more detailed information about the presentations refer to the Help available via 
the upper toolbar when operating the software.  
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Toolbar 

A toolbar is displayed at the top of the screen at all times, so users can jump 
immediately to the facility they require, as shown: 

 

The upper menu expands as a dropdown menu when the cursor is placed over a 
name. 

The lower row of icons (standard for all Armfield Software) allows a particular 
function to be selected. To aid recognition, pop-up text names appear when the 
cursor is placed over the icon. 

Mimic Diagram 

The Mimic Diagram is the most commonly used screen and gives a pictorial 
representation of the equipment, with boxes to enter measurements from the 
equipment, display any calculated variables etc. directly in engineering units. 

To view the Mimic Diagram click the View Diagram icon    from the main tool bar 
or click Diagram from the View drop-down menu as shown: 

 

The mimic diagram displayed will depend on the accessory connected to the F1-10. 
Refer to ‘Operating the Software’ in the instruction manual supplied with the 
accessory for more details about the mimic diagram displayed. 

Manual data input boxes with a coloured background allow measured variables, 
constants such as Orifice Cd and Atmospheric Pressure, as appropriate, to be 
changed by over-typing the default value. After typing the value press the Return key 
or click on a different box to enter the value. 

In addition to measured variables such as Volume, Time, Temperature or Pressure, 
calculated data such as Discharge / Volume flowrate, Headloss etc are continuously 
displayed in data boxes with a white background. These are automatically updated 
and cannot be changed by the user. 

After entering a complete set of data from measurements on the equipment click on 

the  icon to save the set of results before entering another set. 

The mimic diagram associated with some products includes the facility to select 
different experiments or different accessories, usually on the left hand side of the 
screen, as shown: 
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Clicking on the appropriate accessory or exercise will change the associated mimic 
diagram, table, graphs etc to suit the exercise being performed. 

Data Logging Facilities in the Mimic Diagram 

Armfield software designed for manual entry of measured variables does not include 
automatic data logging facilities and these options are greyed out where not 

appropriate. When manually entering data the   icon simply saves the set of 
entered data into a spreadsheet as described above. 

Tabular Display 

To view the Table screen click the View Table icon   from the main tool bar or 
click Table from the View dropdown menu as 
shown:

  

The data is displayed in a tabular format, similar to the screen as shown: 
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As the data is sampled, it is stored in spreadsheet format, updated each time the 
data is sampled. The table also contains columns for the calculated values.  

New sheets can be added to the spreadsheet for different data runs by clicking the 

   icon from the main toolbar. Sheets can be renamed by double clicking on the 
sheet name at the bottom left corner of the screen (initially Run 1, Run 2 etc) then 
entering the required name. 

For more detailed information about Data Logging and changing the settings within 
the software refer to the Help available via the upper toolbar when operating the 
software. 

Graphical Display 

When several samples have been recorded, they can be viewed in graphical format. 

To view the data in Graphical format click the View graph icon  from the main 
tool bar or click Graph from the View drop-down menu as shown: 

 

The results are displayed in a graphical format as shown:  
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Operation 

 

(The actual graph displayed will depend on the product selected and the exercise 
that is being conducted, the data that has been logged and the parameter(s) that has 
been selected). 

Powerful and flexible graph plotting tools are available in the software, allowing the 
user full choice over what is displayed, including dual y axes, points or lines, 
displaying data from different runs, etc. Formatting and scaling is done automatically 
by default, but can be changed manually if required. 

To change the data displayed on the Graph click Graph Data from the Format 
dropdown menu as shown: 

 

The available parameters (Series of data) are displayed in the left hand pane as 
shown: 
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Two axes are available for plotting, allowing series with different scaling to be 
presented on the same x axis. 

To select a series for plotting, click the appropriate series in the left pane so that it is 
highlighted then click the appropriate right-facing arrow to move the series into one of 
the windows in the right hand pane. Multiple series with the same scaling can be 
plotted simultaneously by moving them all into the same window in the right pane. 

To remove a series from the graph, click the appropriate series in the right pane so 
that it is highlighted then click the appropriate left-facing arrow to move the series into 
the left pane. 

The X-Axis Content is chosen by default to suit the exercise. The content can be 
changed if appropriate by opening the drop down menu at the top of the window. 

The format of the graphs, scaling of the axes etc. can be changed if required by 
clicking Graph in the Format drop-down menu as shown: 

 

For more detailed information about changing these settings refer to the Help 
available via the upper toolbar when operating the software.  
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Equipment Specifications 

Overall Dimensions 
The overall dimensions of the F1-10 Hydraulics Bench are as follows: 

Length    -   1.13m 

Width      -   0.73m 

Height     -   1.00m 

Equipment Location 
The equipment is designed to stand on level ground capable of carrying the loadings 
involved. Access is required all round the service unit. 

The equipment requires connection to a single phase, fused electrical supply. Five 
metres of supply cable are included with the equipment. 

The equipment is a self-contained unit and needs only a temporary supply of cold 
water for the initial filling of the sump tank and for cleaning/flushing purposes. 

Equipment Details 

Circulating Pump: 

  

  

  

Type: Centrifugal 

Max. head: 21m H2O 

Max. flow: 80 litres/min (using volumetric 
tank) 

Max. flow: 100 litres/min (using 
appropriate accessory) 

Pump motor rating: 0.37kW  

Sump tank capacity: 250 litres  

High-flow volumetric tank capacity: 40 litres  

Low-flow volumetric tank capacity: 6 litres  
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Pump Performance Curve 

 

Pump Performance Curve for CDX 70/05 and CPm130 

Environmental Conditions 
This equipment has been designed for operation in the following environmental 
conditions. Operation outside of these conditions may result reduced performance, 
damage to the equipment or hazard to the operator. 

a. Indoor use; 

b. Altitude up to 2000 m; 

c. Temperature 5 °C to 40 °C; 

d. Maximum relative humidity 80 % for temperatures up to 31 °C, decreasing 
linearly to 50 % relative humidity at 40 °C; 

e. Mains supply voltage fluctuations up to ±10 % of the nominal voltage; 

f. Transient over-voltages typically present on the MAINS supply; 

NOTE: The normal level of transient over-voltages is impulse withstand (over-
voltage) category II of IEC 60364-4-443; 

g. Pollution degree 2. 

Normally only nonconductive pollution occurs. 

Temporary conductivity caused by condensation is to be expected. 

Typical of an office or laboratory environment 
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Routine Maintenance 

Responsibility 
To preserve the life and efficient operation of the equipment it is important that the 
equipment is properly maintained. Regular maintenance of the equipment is the 
responsibility of the end user and must be performed by qualified personnel who 
understand the operation of the equipment. 

General 
In addition to regular maintenance the following notes should be observed: 

1. When not in use the Hydraulics Bench should be disconnected from the 
electricity supply. 

2. The bench should be disconnected from the electricity supply during all 
maintenance operations. 

3. After use, all accessories should be removed from the bench, drained of 
water and cleaned thoroughly. 

4. If the bench is not to be used for any period of time all water should be 
drained via the drain valve in the front wall of the sump tank. A sponge may 
be used to remove any remaining water from the bench top flow channel and 
volumetric tank. 

5. The bench mouldings should be cleaned regularly using a mild detergent or 
cleaning agent suitable for use with plastics. 

6. The water in the sump tank should be replaced at regular intervals. 

When dye is used with appropriate accessories the water will require replacing 
more frequently. It is suggested that the sump tank is flushed through several 
times with clean water to remove any contamination. Any dye used must be 
non-staining and safe for student use. 

Note: If necessary the moulded top can be removed to gain access to the 
sump tank if cleaning is necessary. The top moulding should be lifted partially 
and retained in this position using suitable supports. The flexible connections 
between the pump/bench top inlet and sight tube/tapping at the base of the 
volumetric tank should be disconnected. The top moulding can then be lifted 
clear of the bottom moulding. 

Reassembly is the reverse of the above procedure. 

The centrifugal pump is located in a recess below the sump tank. The pump 
should not normally require any maintenance. However, if access to the pump 
is required then the sump tank should be drained, the top should be removed 
as described above then the lower moulding should be tipped over onto one 
side on to a large piece of cardboard or similar to protect the moulding from 
damage. 



 

Contact Details for Further Information 
  

Main Office: Armfield Limited 

Bridge House 
West Street 
Ringwood 
Hampshire 
England BH24 1DY 

Tel: +44 (0)1425 478781 
Fax: +44 (0)1425 470916 
Email: sales@armfield.co.uk 
Web: http://www.armfield.co.uk 

  

US Office: Armfield Inc. 

436 West Commodore Blvd (#2) 
Jackson, NJ 08527 

Tel: (732) 928 3332 
Fax: (732) 928 3542 
Email: info@armfieldinc.com 
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